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Introduction 
From all of us at Control Vision Corporation, Thank you for 
purchasing Pocket Plates 3 software. Pocket Plates is an IFR 
expansion pack for the Anywhere Map software and is engineered to 
give the user seamless access to the US Terminal Procedures, 
(TERPs) commonly referred to as “government plates,” published by 
NACO, the FAA charting office. Pocket Plates makes it economical 
and practical to have a complete, Part 91 compliant set of current 

approach plates available at all times. More than 16,000 procedures 
easily fit on a single Secure Digital data card, allowing you to 
literally carry the equivalent of 24 pounds of printed books in a 
Tablet PC, Ultra Mobile PC, or in the Anywhere Travel 
Companion. There are also several tools built into the software that 
can be used to enhance the plates for added situational awareness 
during the approach. Pocket Plates software does not contain low-
enroute charts. This manual will cover installation, use, and 
troubleshooting tips for Pocket Plates 3 software. 

 

There are 2 components to the Pocket Plates 3 suite. Depending on 
the machine you’re using, you may use one or both applications.  

� Pocket Plates PRO for PC 

� Pocket Plates for Anywhere Travel Companion (ATC) 

 

Pocket Plates PRO ( PP PRO ) is a Windows application created 
specifically for Windows 2000, NT, XP, and Vista operating systems 
and is delivered on DVD. You’ll need a minimum of 128 MB of 
RAM, 3GB of disk space, and a DVD ROM drive for installation. A 
high-speed Internet connection is highly recommended for quick 
updating each month. PP PRO delivers a complete set of NACO 
‘paper books’ including Terminal Area Procedures (TERPs) as well 
as Standard Instrument Departures (SIDs), Standard Terminal 
Arrival Procedures (STARs), and Airport Diagrams (apdgs) in a 
digital, high resolution, geo referenced format for display on a tablet, 
laptop, or desktop PC. If you fly with a Tablet PC such as a Motion 
LS800 or a Samsung Q1, this is the only utility you’ll need to 
display any of the above-mentioned items. A NMEA compatible 
GPS such as the QSTARZ or HAICOM 408BT GPS can be used to 
provide GPS positioning over the top of the plate. This application 
is also used to print paper ‘hard copies’ and acts as the update agent 
for the ATC. 

 

Pocket Plates for Anywhere Travel Companion (PP ATC) is a full-
featured version of the program designed and engineered specifically 
for the ATC. PP ATC delivers all the same components as the PP 
PRO application and requires a pre-installed 4GB Secure Digital 
memory card supplied by Control Vision Corp. PP ATC will only 
operate on the ATC device. 

 

Note: The Pocket Plates 3 software purchase may include 6 OR 12 
months of free subscription time depending on the system package 
purchased. Check your original invoice for a line item showing the 
subscription length purchased with your system. After this time has 
expired, an annual or lifetime subscription may be purchased for 
continued support and updates. This subscription provides access to 
all of the plates for the USA as well as updates to the PC and ATC 
applications. 
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Pocket Plates PRO 
Important: You must register the Pocket Plates PRO software before 
initial installation and updates can be performed. Find your Product 
Activation Code in the Pocket Plates PRO DVD case and visit the 
Product Registration portion of our website here: 
http://www.anywheremap.com/registration.aspx The Product 
Activation Key is case sensitive; enter it exactly as printed. Existing 
Anywhere Map or Pocket Plates customers must register the new 
Pocket Plates PRO software using their existing username and 
password. New user Registration generates a unique username and 
password, which you will need for updates. On completion of 
Registration you’ll be given a user account page to print for your 
records. Also, expect an email momentarily with your new Username 
and Password. Store this information for later reference. 

Installation 
After registering the Pocket Plates Pro software, insert the DVD into 
your host computer’s DVD ROM drive. Autoplay should engage 
the installer on your computer, otherwise click > My computer and 
double click on the DVD ROM drive. Choose the appropriate 
options to install Pocket Plates PRO to the PC and click Install. 
Installation may take 10-40 minutes depending on PC performance. 

 

Using Pocket Plates PRO 
Start Pocket Plates Pro by clicking >Start >Programs >Pocket Plates 
>Pocket Plates PRO. The first time you run Pocket Plates PRO on 
your PC, make sure to click >File >Configure >Set 
Username/Password and enter the case sensitive username and 
password from the registration. 

After boot, the Pocket Plates PRO window will always display the 
last plate viewed in the main window (it will be blank on the first 
use).  

Toolbars:  

 

Main Toolbar: 
1. Left Arrow: Turns to the previous page of the previous plate as 

they are ordered in the printed, paper plate books 

2. Airport Lookup button: Used to search for the desired airport’s 
plates that you wish to use. You do not have to enter the ICAO 
‘K’ when entering the identifier. As you enter the identifier, the 
auto-complete window will list probable matches for the 
characters entered. Complete the identifier or tap on the desired 
one from the auto-complete window to view a list of the 
approaches for that airport. You can also view the Arrivals or 
Departures for this particular airport by clicking the appropriate 
tab at the top of the main list box. After selecting the plate, 
SID, or STAR by clicking on it, click Done at the bottom to 
retrieve the image from the library for display. 

3. Airport Diagram toggle: Activates the apdg image for the 
selected airport. This button is ‘faded out’ if no diagram is 
available for the selected airport.  

4. Approach Plate toggle: Activates the approach plate pages of the 
selected airport.  

5. ARV button: Activates the STAR (arrival procedure) for the 
selected airport.  

6. DEP button: Activates the SID (departure procedure) for the 
selected airport. 

7. Toolbar toggle button: Activates/deactivates the settings 
toolbar. 

8. Right Arrow: Turns to the previous page of the previous plate as 
they are ordered in the printed, paper plate books. 

 

Display Toolbar 

 

1. Alternate Toolbar toggle: 2-way toggle between the Display 
Toolbar and the Settings Toolbar. 

2. Night/Day Toggle: Changes the background color of the plate 
from white to black. 

3. Ultra TAWS toggle: Applies 90 meter Ultra TAWS data over 
the plan view of the plate. This feature requires the Ultra 
TAWS Expansion pack for Anywhere Map XP v2.1 or higher. 
This button will be grey if you do not have the expansion pack 
installed/license key entered. 

4. NEXRAD toggle: Applies the current Nexrad image from 
Anywhere Map XP to be displayed over the plan view of the 
plate. The age of the Nexrad file displays on the bottom status 
bar of the application. This feature is only compatible with the 
XM Satellite Weather Nexrad file. Anywhere Link Nexrad 
cannot be used. 

5. Drawing Toolbar: Activates a ‘doodle’ feature making the plate 
image act like a piece of scratch paper. This toolbar now appears 
over the plate image. When the toolbar is shown, you may 
write/draw on the plate. Click the eraser icon to clear the entire 
‘doodle’. To leave your ‘doodle’ visible and return to panning 
mode, click the Drawing Toolbar icon again or click the X on 
the Drawing Toolbar to close it. Now the pan mode is re-
engaged.  

6. Zoom Level 1: Fits the plate to the width of the screen. 

7. Zoom Level 2:  

8. Zoom Level 3:  
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Settings Toolbar 
 

 

1. Alternate Toolbar toggle: 2-way toggle between the Display 
Toolbar and the Settings Toolbar. 

2. Settings button: Activates the Pocket Plates Settings screen. 
GPS Settings, Download Settings, and WX/Terrain overlay 
opacity. 

3. Web Update button: Activates the web update function for 
monthly updates to the plates. Connect your PC to the internet 
before starting the process. 

4. Legends/Tables button: Activates the legends and tables menus 
of the plate books. 

5. Filter Setup Button: Activates the Filter Settings to let you select 
the region, state, or type of approaches that you wish to keep 
current. The system defaults to ALL states, Regions, and Plate 
types. 

6. Calibration button: Can be used to recalibrate plates if the geo-
referenced points don’t seem to be accurate. 

7. Print: Activates the print function for each plate. Most inkjet 
and laser printers work well. Plates will print on a half-sheet of 
paper. 

8. About: Displays the installed version number of PP PRO. 

 

Updating Pocket Plates PRO 
1. Updates for the Pocket Plates libraries are published every 28 

days on the normal FAA/NACO cycle dates by Control Vision 
Corp to the Web Update Server. To obtain these updates, 
connect your host PC to the internet and open Pocket Plates 
PRO by clicking >Start >Programs >Pocket Plates >Pocket 
Plates PRO.  

2. From the Settings Toolbar select the Web Update 
button. This will connect the PP PRO application 
to the Web Update Server.  

3. Upon automatic verification of your Pocket Plates 
registration/subscription, PP PRO will scan the PC to discover 
which database version is currently installed and which plates 
need to be updated on the current cycle. This process is called 
Validation and can take 1-3 minutes depending on PC 
performance. 

4. Once the Validation is complete, PP PRO will automatically 
begin downloading updated plate data to the PC. This process 
can take 5-30 minutes on a high-speed internet connection 
depending on how many plates the government has updated 
since your last update*. It can take many hours to complete if 
you use a dial-up connection. This process can be cancelled and 

restarted at any time and will not lose any data received, but 
instead will simply pick up where it left off.  

5. After the download session has completed the Pocket Plates 
library on the PC is now completely updated. You’ll now be 
given the option to update an Anywhere Travel Companion. If 
you use an ATC and wish to update it with the new plates 
follow the on-screen prompts (See the section Updating Pocket 
Plates on the ATC). Otherwise, click No to updating the ATC. 
PP PRO should now be closed and restarted for further use. 

Troubleshooting 

1. Active Firewalls such as Norton Internet Security, Norton 360, 
McAfee, Zone Alarm, and Black Ice can block the ability for 
Pocket Plates PRO to download updates from the Web Update 
Server. Disabling these applications before attempting first time 
installations or the update process can be essential to success.  

2. To enable your GPS position to be shown over the plate image 
all civilian airport plates are pre-calibrated and double-checked 
for quality control. SIDs, STARs, and many military airport 
plates may not be calibrated as very few are ‘to scale’. If the 
images are not scaled correctly, calibration does not work and 
your GPS position will definitely be inaccurate. If you 
encounter any plates that are not calibrated, please email the 
identifier to support@controlvision.com with the subject line of 
ATC PlateCal. You may not receive a response, but your help is 
appreciated. These plates will be filtered on the next update and 
re-calibrated. 

mailto:support@controlvision.com
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Pocket Plates on Anywhere Travel Companion 
  

Installation 
1. When Pocket Plates is purchased for the ATC, it is delivered on 

a DVD ROM, and a 4GB High Capacity Secure Digital 
(SDHC) data card.  
 
This card has been pre-configured with the complete library of 
TERPs, SIDs, STARs, and airport diagrams. Inserting this card 
into the ATC will install/enable the Pocket Plates application 
for immediate operation. 

2. The 4GB SDHC data card also contains the complete 
Anywhere Map (AWM) nav databases, so if you’re upgrading 
an existing ATC with PP ATC, simply remove the 1GB data 
card and insert the 4GB data card and you’re ready to begin 
using both applications. 

3. When you’re ready to update the plate library the first time you 
must install the Pocket Plates PRO application from the DVD 
ROM mentioned above to your host PC. See Installation under 
Pocket Plates PRO, and Updating Pocket Plates on the ATC in 
step 3 of this section for more detailed instructions. 

Using Pocket Plates on the ATC 
1. There are two ways to launch Pocket Plates on the ATC. You 

can tap the far left icon on the main ATC Main Launcher 
screen or tap the 2nd icon on the left hand toolbar in Anywhere 
Map* 

2. PP ATC will always launch to the last viewed plate in a ‘fit to 
width’ format (a random plate –from factory QC testing- may 
be displayed when the app is used for the first time). 

 

3. An up or down sliding gesture with your finger or stylus on the 
screen will pan the plate image up or down. When the plate 
image has been enlarged using the Zoom button, you may also 
use sideways, diagonal, or circular sliding gestures to maneuver 
the plate image to the desired position. 

 

 

4. Toolbars: Intuitive toolbars that can be shown and hidden by 
tapping the ‘- or +‘ button in the lower left corner of the screen. 
Buttons that can be used are bold, but are slightly faded out if 
that particular feature isn’t able to be used in the current state of 
operation. For example, if you’re viewing a plate for an airport 
without an arrival procedure, the ‘ARV’ button will be disabled. 

Left Toolbar 
1. Left Arrow: Turns to the previous page of the previous 

plate as they are ordered in the printed, paper plate 
books. 

2. Anywhere Map toggle*: Activates AWM. In AWM, the 
corresponding icon on the toolbar toggles you back to 
Pocket Plates. 

3. Airport Diagram toggle: Activates the apdg image for 
the selected airport. This button is ‘faded out’ if no 
diagram is available for the selected airport.  

4. Approach Plate toggle: Activates the approach plate 
pages of the selected airport. 

5. Lookup/Approach List button: Activates the Airport Lookup 
screen to search for the desired airport and/or choose from the 
list of procedures for the selected airport. The last airport id 
used will appear in the Ident Box in the top left corner and list 
of approaches on the right. Before typing, tap in the ident box 
(top left corner) to place the cursor and <BS or ‘backspace’ to 
clear the previous ident before entering a new one. If you click 
Done with an empty ident box, the plate screen will clear 
automatically. As you enter the identifier, the auto-complete 
window will list probable matches for the characters entered. 
Do not enter the ICAO ‘K’ when typing the identifier into the 
top Left field. Complete the identifier or tap on the desired one 
from the auto-complete window to view a list of the approaches 
for that airport. You can also view the Arrivals or Departures for 
the selected airport by clicking the appropriate tab at the top of 
the main list box. After selecting the plate, SID, or STAR by 
clicking on it, click >Done at the bottom to retrieve the image 
from the library for display. 
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Right Toolbar 
1. Right Arrow: Turns to the previous page of the previous 

plate as they are ordered in the printed, paper plate 
books. 

2. Legends/Tables button: Activates the legends and tables 
menus of the plate books.  

3. ARV button: Activates the STAR (arrival procedure) for 
the selected airport. 

4. DEP button: Activates the SID (departure procedure) 
for the selected airport. 

5. Tools button: Button label indicates active mode. 

a. Drag-To-Pan/Tap-To-Pan toggle: Drag pan mode is 
the default and most popular. Tap pan mode centers 
the image on the point you tap. 

b. Day mode/Night Mode toggle: changes the 
background of the image from white to black. The 
brightness of the display can only be changed in the 
Anywhere Map application. 

c. Drawing Toolbar: Activates a ‘doodle’ feature making 
the plate image act like a piece of scratch paper. This 
toolbar now appears over the plate image. When the 
pencil icon is shown, you may write/draw on the plate. 
Tap the eraser icon to clear the entire ‘doodle’. To 
leave your ‘doodle’ and drawing toolbar active and 
return to panning mode, tap the pencil icon to change 
it to a hand icon. Now the pan mode is re-engaged. 
Tapping the hand will toggle you back to writing 
mode. Clicking the X will close the Drawing Toolbar. 

d. About button: Recalls the version number and 
effective dates of the plate libraries currently installed. 
This button was disabled in the BETA version of 
Pocket Plates. 

6. Zoom button: 3-way toggle. Changes the magnification of the 
procedure image. –Fit to Width, Zoom 2x, Zoom 4x- 

 

Note: When toggling between any procedure image the zoom level is 
never altered. Only the Zoom button will change the scale of the 
image. 

*This feature requires Anywhere Map version 1.98.864 or later. 

Updating Pocket Plates on the ATC 
1. First, follow the instructions from 3. Updating Pocket Plates 

PRO to update the plate libraries on your host PC. 

2. Upon completion of the above update, you will be prompted to 
install the newly updated libraries to the ATC. Click >Yes to 
begin loading to the 4GB SDHC data card of the ATC. 

3. Loading the new plate libraries to the ATC handheld can take 
15 minutes to several hours depending on PC performance 

(USB 2.0 ports speed the process significantly) and the number 
of plate files that have changed since your last update. 

Troubleshooting 

1. >Tools >Help and >Tools >About menus are disabled in the 
BETA version of Pocket Plates. 

2. Active Firewalls such as Norton Internet Security, Norton 360, 
McAfee, Zone Alarm, and Black Ice can block the ability for 
Pocket Plates PRO to download updates from the Web Update 
Server. Disabling these applications before attempting first time 
installations or the update process can be essential to success.  

3. To enable your GPS position to be shown over the plate image 
all civilian airport plates are pre-calibrated and double-checked 
for quality control. SIDs, STARs, and many military airport 
plates may not be calibrated as very few are ‘to scale’. If the 
images are not scaled correctly, calibration does not work and 
your GPS will definitely be inaccurate. If you encounter any 
civilian airport plates that are not calibrated, please email the 
identifier to support@controlvision.com with the subject line of 
ATC PlateCal . You may not receive a response, but these plates 
will be filtered on the next update and re-calibrated. 
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